
HP Project and Portfolio 
Management Center
Software Version: 9.30

Release Notes

 

Document Release Date: September 2014
Software Release Date: September 2014

 



Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be 
construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 
Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© Copyright 1997 - 2014 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe® is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.
 l Document Release Date, which changes each time the document is updated.
 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:           http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:           http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

The following table indicates changes made to this document since the last released edition.

Support
Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your 
business. As a valued support customer, you can benefit by using the support web site to:

 l Search for knowledge documents of interest
 l Submit and track support cases and enhancement requests
 l Download software patches
 l Manage support contracts
 l Look up HP support contacts
 l Review information about available services
 l Enter into discussions with other software customers
 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp
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HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your business 
needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is 
http://h20230.www2.hp.com/sc/solutions/index.jsp
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Overview of Version 9.30
This document provides an overview of the changes made to Project and Portfolio Management Center 
(PPM Center) for version 9.30. It contains important information not included in the manuals. The 
section "Known Problems and Limitations" on page 9 provides information about the changes 
introduced with the enhancements and fixes for version 9.30.

Scope of this Release
PPM Center version 9.30 improves many aspects of the product, including upgrade and functional 
areas. 

For details about enhancements in this release, see the What’s New and What’s Changed guide. You 
can find this and other PPM Center documents as described in "Documentation for PPM Center 
Version 9.30" below. 

Caution: Defect fixes included in versions 9.21, 9.22, and patches (up until 9.22.0003) on top of 
version 9.22 are rolled into version 9.30. If you are on PPM Center patch 9.22.0004 (or later), do not 
upgrade to PPM Center version 9.30 yet, otherwise you may encounter some regressions 
regarding the defect fixes included in 9.22.0004. You may want to wait for the next available patch 
on top of version 9.30 to have those defect fixes.

Documentation for PPM Center Version 9.30
All documentation for PPM Center version 9.30 can be found in the product as well as at the HP 
Software Product Manuals site at the following URL:

(http://h20230.www2.hp.com/selfsolve/manuals).

All of the documentation is available in both Adobe Acrobat (.pdf) format and the majority of the 
documentation is available in online help format.

You can also access PPM Center documentation through the links provided under topic areas of your 
interest on the PPM Center Help Center page (Help > Help Center). 

Note that the following documentation is not included initially in your installation of PPM Center as they 
may contain last minute changes:

 l Release Notes for PPM Center 9.30

 l Release Notes for Language Pack for PPM Center 9.30
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 l System Requirements and Compatibility Matrix

 l Overview of Platform Support

To download documentation, to check for updates, or to confirm that you have the most recent version, 
visit the following URL:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, 
go to:

http://h20229.www2.hp.com/passport-registration.html

Or click the New user - please register link on the HP Passport login page.

You will receive updated or new editions if you subscribe to the applicable product support service. 
Contact your HP sales representative for details.

Note: To view files in PDF format (*.pdf), you must have Adobe Acrobat Reader installed on your 
system. To download Adobe Acrobat Reader, go to: http://www.adobe.com.

Installation Notes
Instructions for installing PPM Center version 9.30 are provided in the Installation and Administration 
Guide.

Note: You can obtain the most recent edition of the Installation and Administration Guide from HP 
Manual site by clicking here. It contains some last minute updates that were not included in the 
Online Help version.

Instructions for upgrading to PPM Center version 9.30 are provided in the Upgrade Guide.

If you plan to implement Operational Reporting for PPM Center, see the Operational Reporting 
Administrator’s Guide for instructions.

If you are installing a language pack, see the Release Notes for Language Pack for PPM Center 9.30, 
available at the HP Manuals site.
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Updates to HP Deployment Management Extension 
for Oracle E-Business Suite and HP GL Migrator to 
Support Oracle E-Business Suite Release 12
A set of jars for the HP Deployment Management Extension for Oracle E-Business Suite and HP GL 
Migrator version 9.12 provide support for Oracle E-Business Suite Release 12.

For detailed information about supportability of HP GL Migrator version 9.12 with various releases of 
Oracle E-Business Suite and with various versions of PPM Center and HP Object Migrator, see the 
latest System Requirements and Compatibility Matrix for PPM Center version 9.3x.

For detailed information about HP GL Migrator version 9.12, including installation and upgrade 
procedures, see the HP GL Migrator Guide for version 9.12.

A specific product installation or upgrade sequence must be followed when using PPM Center version 
9.3x, as described in "Product Installation Sequence with PPM Center Version 9.3x" on the next page.

New Object Types Provided in Extension Jars 
As described in "Product Installation Sequence with PPM Center Version 9.3x" on the next page, the 
jars for the HP Deployment Management Extension for Oracle E-Business Suite must be installed. The 
jars install the following PPM Center object types that must be used to support migrations for Oracle E-
Business Suite Release 12:

 l GL 912 :Budget Organisation

 l GL 912 :Consolidations

 l GL 912 :Cross Validation Rules

 l GL 912 :FSG Row/Col Sets

 l GL 912 :Journal Categories

 l GL 912 :Journal Entry Sources

 l GL 912 :Mass Allocation/Budget

 l GL 912 :Summary Templates

These new object types are analogous to existing object types that do not have the "GL 912 :" prefix, 
except that the GL 912 :FSG Row/Col Sets object type is provided in HP GL Migrator version 9.12 for 
the first time (see HP GL Migrator Guide for version 9.12).
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These object types are backward compatible with Oracle E-Business Suite Release 11i, and installing 
them does not overwrite any existing object types.

Product Installation Sequence with PPM Center Version 
9.3x
To prepare to deploy HP GL Migrator version 9.12 and associated prerequisities, download the 
extension jar files described below for HP Deployment Management Extension for Oracle E-Business 
Suite, which bundles the following files:

 l The following zip files for HP GL Migrator version 9.12:

 n CLGM_912.zip  

 n CLGM_UPG_912.zip  

 l The following zip files for HP Object Migrator version 7.5:

 n CLM_75.zip  

 n CLM_75_tar.gz  

 n CLM_UPG75.zip  

 n CLM_UPG75_tar.gz  

 l The following jar files for the HP Deployment Management Extension for Oracle E-Business Suite 
patch:

ppm-930-OracleApps.jar

ppm-930-OracleApps912.jar 

 l The following jar file for the HP Deployment Management Extension for Oracle Technology version 
9.30:

ppm-930-OracleTech.jar 

Starting with PPM Center version 9.30 (with or without an associated service pack) as a basis, the 
following product installations or upgrades must be performed in the following sequence to support 
using the HP Deployment Management Extension for Oracle E-Business Suite and HP GL Migrator 
with Oracle E-Business Suite Release 12:

 1. HP Object Migrator version 7.5, if not already installed. 

See the HP Object Migrator Guide for version 7.5.

 2. HP GL Migrator version 9.12. 

Release Notes
Overview of Version 9.30

HP Project and Portfolio Management Center (9.30) Page 8 of 34



See the HP GL Migrator Guide for version 9.12.

 3. PPM Center version 9.30, if not already installed. 

See the Installation and Administration Guide for version 9.30 and service pack Release Notes as 
appropriate.

 4. HP Deployment Management Extension for Oracle E-Business Suite version 9.30, if not already 
installed. 

See the HP Deployment Management Extension for Oracle E-Business Suite Guide for version 
9.30.

 5. HP Deployment Management Extension for Oracle E-Business Suite to allow the HP Deployment 
Management Extension for Oracle E-Business Suite version 9.30 and HP GL Migrator version 
9.12 to support Oracle E-Business Suite Release 12.

Note: To deploy extensions jars, you must use the following installation command:

sh kDeploy.sh -i OracleApps912

The HP Deployment Management Extension for Oracle Technology can be installed at any time after 
PPM Center version 9.3x is installed.

Software and Hardware Requirements
Before you install PPM Center version 9.30, make sure that your system meets the minimum 
requirements, as described in the System Requirements and Compatibility Matrix, available at the HP 
Manuals site.

Known Problems and Limitations
The following problems and limitations are known to exist in PPM Center version 9.30 (or other 
software, as indicated). The problems are categorized by the affected product area. If a problem has an 
assigned internal tracking number, that tracking number is provided (in parentheses) at the end of the 
problem description.

Accelerators - Best Practices

Problem: (PPM Center version 9.20 or later) After deploying the best practices, when clicking Search 
> Project Risk, the following error occurs: "Request type business key, _PROJECT_RISK not 
found". (QCCR1L51372)
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Workaround: After upgrading your PPM Center instance to version 9.30, if the problem exists, run the 
following command to re-deploy the updated best practices bundle available with version 9.30:

sh ./kDeploy.sh -best-practices

Dashboard

Problem: When a request contains HTML related characters in its request description, the request is 
not displayed in the My Requests portlet. (QCCR1L42543)

Workaround: Make sure not to include any HTML related characters in the description of a request.

Problem: Any PPM Center portlets that contain the word “program” do not display the new Chinese 
translation for “program” and instead display the old Chinese translation for “program”. (QCCR1L27636)

Workaround: None.

Problem: When the length of a word in a portlet name exceeds 30 characters (without aspace), after 
you click Find Portlets in the Add Portlets window, the Portlet Namecolumn in the resulting list is 
resized automatically, other columns are pushed to theright side, and no horizontal scrollbar is 
available. If the word is really long (say, 100 characters), the buttons in the right side of the window may 
disappear. (QCCR1L41717)

Workaround: Maximize the Add Portlets window.

HP Demand Management

Limitation: If you use the same token in both the WHERE clause of an ACL validation's SQL 
statement and the SQL statement of the validation's filter field, PPM Center may return no value for the 
ACL field when you change the value of the field associated with the token in PPM Center Web pages. 
(QCCR1L54208)

Workaround:  This is because the value of the token used in the WHERE clause of the ACL 
validation's SQL statement is retrieved from the Web pages, while the value of the token used in the 
SQL statement of the validation's filter field is retrieved from PPM Center database. 

To avoid this issue, HP recommends that you not use the same token in the WHERE clause of an ACL 
validation's SQL statement and the SQL statement of the validation's filter field.

Problem: The maximum entry number allowed for fields of table component type is 500. 
(QCCR1L55387)

Workaround: None.
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Limitation: If a user only has the access grant of a workflow step, when searching requests, the user 
cannot select the request type that uses this workflow. (QCCR1L44594)

Workaround: None.

Limitation: On the Request Search Results page, when you select several requests and click the Edit 
> Quick Edit button, you receive the following error message:

An unknown error has occurred. For more information, please contact your PPM 
administrator and provide the following GUID number...

(QCCR1L50677)

Workaround: To resolve this issue, do one of the following:

 l Select fewer requests and then click the Edit > Quick Edit button.

 l Configure as follows:

 a. Stop PPM Server.

 b. Open the <PPM_Home>/server/<PPM_Server_Name>/deploy/jbossweb-
tomcat55.sar/server.xml file, and add maxPostSize="0" right after maxThreads="150".

 c. Click Save to save your changes.

 d. Clean up the <PPM_Home>/server/<PPM_Server_Name>/tmp and the<PPM_
Home>/server/<PPM_Server_Name>/work directories.

 e. Restart PPM Server.

Limitation: PPM Center fails to send notifications for a workflow step, when there are many recipients 
and you configure as follows:

 1. In the Add New Recipient window of PPM Workbench, select Enter a User Defined Token.

 2. In the User Defined Token field, enter the token name of a text field.

 3. In the Recipient Type field, select Email Address. (QCCR1L51955)

Workaround: The root cause is that for text fields, the database column used to store email addresses 
of recipients has a character limitation of 80 (including separators).

To resolve the issue, stop PPM Server and run the following SQL:

alter table knta_notif_txn_recipients modify email_address varchar(1000 CHAR);

If you encounter errors related with the KNTA_NOTIFICATION package after running the SQL, recompile 
all packages.

Limitation: When using the Request Browser to search requests (Open > Demand Management > 
Request Browser > Browse Requests), a user can select a maximum of 8 values for the Column 
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Values field in the Choose Additional Column to Display in Request Browser Tree section. 
(QCCR1L51965)

Workaround: Starting from PPM Center version 9.22, a user can select a maximum of 12 values  for 
the Column Values field.

Problem: When sending notifications of a workflow step or request field change, PPM Center behaves 
as follows:

 l For recipients  who are PPM Center users and have already logged on to PPM Center at least once, 
PPM Center groups them together according to their user locales (user locale includes regional 
settings and display language).

 l For recipients who are not PPM Center users and who have  PPM Center user accounts but have 
never logged on to PPM Center, PPM Center groups them together.

As a result, recipients in different groups receive different notification emails.  (QCCR1L52110, 
QCCR1L52245)

Workaround: This is because only PPM Center users who have already logged on to PPM Center at 
least once have locales. To resolve this issue, do the following to define a default locale for all non-
PPM Center users and PPM Center users who have never logged on to PPM Center:

 1. Set a value for the SERVER_LOCALE_COUNTRY_CODE server configuration parameter. The default 
value is null. Valid values are any two-letter abbreviation of a country in uppercase.

For example, if you want to set the default regional settings to United States, set the SERVER_
LOCALE_COUNTRY_CODE server configuration parameter  to US.

 2. Set a value for the SERVER_LOCALE_LANGUAGE_CODE server configuration parameter.The default 
value is null. Valid values are any two-letter abbreviation of a language in lowercase.

For example, if you want to set the default display language to English, set the SERVER_LOCALE_
LANGUAGE_CODE server configuration parameter to en.

This ensures that PPM Center groups all PPM Center users and non-PPM Center users together when 
sending notifications.

Problem: On the Timeout tab of the Workflow Step window in the PPM Workbench, you set a timeout 
for a workflow step to make PPM Center send notifications when the step gets timed out. However, it 
does not work. (QCCR1L47224)

Workaround: The root cause is that the p_step_txn_group_IN_list variable used to store step_
transaction_id has a character limitation, which can contain around 4000 transaction ids.

To solve the issue, use the following query to check if there are too many transactions pending 
notification:
select step_transaction_id FROM KWFL_PENDING_STEP_TIMEOUTS_V

If the number of returned rows exceeds 4000,  update the timeout_date column of the KWFL_Step_
Transactions table. For example, you may run the following SQL:
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update KWFL_STEP_TRANSACTIONS
set TIMEOUT_DATE = sysdate +floor(rownum / 3000)
where STEP_TRANSACTION_ID　in
(select STEP_TrANSACTION_ID from KWFL_PENDING_STEP_TIMEOUTS_V)

After you run the SQL,   the timeout dates of every 3000 rows are updated in batches. The date of the 
first batch is set to the current date and is one day later every time the batch number increases. As a 
result, PPM Center will send notifications of 3000 transactions per day, thus avoid exceeding the 
character limitation.

Limitation: You have a request type whose Request Header Type (RHT) contains an attachment field. 
You submit a request using this request type and attach a file in the field. On the request details page, 
you change the request type to the one using a different RHT and save the change. If attachment fields 
in both target and original RHTs use the same parameter, you receive the following error message 
when clicking the link of the attached file: You do no have access to this page…(KNTA-11013)  

If you change the request type back to the original one, you can access the attached file again. 
(QCCR1L50552)

Workaround: None.

Limitation: PPM Center does not support using UI rule setFieldEditable() to set table component 
validations as editable or read-only. (QCCR1L51073)

Workaround: None.

Limitation: When there are several groups of workflow steps on the Request Details page and the 
browser cannot display all workflow steps,  the More Actions buttons appear. However, one or more 
groups of workflow steps may disappear when you resize or restore down your browser window. This is 
because the resized browser window is not wide enough to display the More Actions buttons. 
(QCCR1L52165) 

Workaround: To resolve this issue, do one of the following:

 l Maximize your browser.

 l From the Control Panel, select a higher screen resolution.

 l Press ctrl and - to zoom out your browser.

Problem: You use a SQL rule to get a project name and display it on the Request Details page. When 
the project name contains an ampersand, the ampersand is not displayed and the name gets truncated 
on the Request Details page. (QCCR1L46993)

Workaround: PPM Center uses #@# as a separator. Make sure that:

 l Values used in SQL rules do not contain &amp; or #@#

 l SQL rules do not contain #@#

You can use # and @ separately.Installation

Release Notes
Overview of Version 9.30

HP Project and Portfolio Management Center (9.30) Page 13 of 34



Problem:  If the previous step is an execution step and the Processing Type is set to Immediate, the 
status dependencies, such as Clear, will not be triggered in the current step. It requires user interaction 
for these types of status dependencies (QCCR1L12363).

Workaround: None .

Problem: After migration from PPM version 7.5 to 8.0, you log on to PPM Center and select German 
as the session language. On the Request Details page or the Search Requests page, you click the 
calendar icon and choose a date (short date). An error message pops up in German: "In the date field 
the wrong format is used and the request cannot be saved." (QCCR1L16011)

Workaround: Change your current regional settings to German (Open >Administration > Edit My 
Profile > Regional Settings).

Limitation: PPM Center stores Request Header Type (RHT) fields in the KCRT_REQ_HEADER_
DETAILS table, which has only 50 columns available. (QCCR1L13835)

Workaround: None.

Problem: If a request contains a rule that uses KNTA_MULTI.Find_User_full_ names([SYS.USER_
ID]) from sys.dual, saving the request may fail or removing associated entities from the request may 
fail. (QCCR1L24349)

Workaround: Use KNTA_MULTI.Find_UserNames([SYS.USER_ID]) from sys.dual instead.

Limitation: When Text Field is set to “is equal to” the value of an Auto Complete List or Drop Down 
List value in the Dependencies section of the Rules tab in the request type workbench, the 
dependencies do not work; However, if the Text Field is set to match the code of the Auto Complete 
List or Drop Down List, the dependencies work well. (QCCR1L27020)

Workaround: Considering the fact that Auto Complete List and/or Drop Down List values can be 
localized, which will then cause consistency issue for the dependencies, HP recommends you to 
match Text Field code to the code of Auto Complete List or Drop Down List when you set up request 
type field dependencies.

Limitation: A token unparseable error occurs when creating a request of a request type, where its 
validation referenced a non-existing token. (QCCR1L27418)

Workaround: When you specify a validation for your request type, report type, or object type, make 
sure that the token(s) referenced by the validation already exist.

Limitation: If you have included too many items in the Request Type field or the Selected Columns 
list on the Search Requests page, an error might occur when you try to save your search preferences. 
(QCCR1L39090, QCCR1L47244)

Workaround: Do not include too many items in the Request Types field or the Selected Columns list 
on the Search Requests page. For better performance, HP recommends that you limit the total size of 
the Request Types field and the Selected Columns list to 1500 characters.
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Limitation:  When applying advanced rules on requests with "Printable Version" and the Print function, 
the previewed and printed data does not match with what is displayed on the screen. (QCCR1L39873)

Workaround: Now rules can be executed on the printable version of Request Details, but with the 
following limitations:

 l Only SQL rules and UI Rule setFieldVisible()will be executed.

 l Only Apply on page load rule event is supported.

 l The printable version should be opened from Request Details page instead of by entering the URL 
address directly.

Limitation: If a field is set to “Display = No" or invisible by status dependency, you can not make it 
visible on the web UI by using UI rules. (QCCR1L40010)

Workaround: None.

Limitation:  SQL for Hierarchical Display (tree validation) now supports resolving such static tokens as 
[SYS.USERNAME] and [SYS.USER_ID].

Other types of tokens, such as Request Details or Context related tokens, are not supported. 
(QCCR1L40379)

Workaround: None available at this time.

Limitation: Auto-complete component's valid value list is not in client UI, so when using rule to set 
values for auto-complete component, the values are not validated and invalid values can be set. As a 
result, when users create a request, a value that is not in auto-complete list can be inserted and saved 
in an auto-complete field as triggered by the SQL rule. (QCCR1L41050)

Workaround: PPM administrators who configure SQL rules to set values for auto-complete list should 
make sure that only valid values are set.

Problem: After you enable field group Program Issue: Allows Requests to be considered as Issues 
In a Program for a request header type, no Program Issue section is added to the Fields tab of the 
request header type.(QCCR1L41722)

Workaround: This behavior is by design and it has no functional impact. Request types using this 
request header type can still be used as program issue type and it works fine for program issue 
tracking.

Limitation: Rule dependency is not supported if the dependency field is using the () pattern to present 
negative numbers. For example, using (1000) to represent -1000. (QCCR1L42478)

Workaround: None available at this time.

Problem: An error occurs when performing Quick Edit or Mass Update on requests ofnon-PFM-
Proposal request types that use PFM - Finish Period by Month validation. This is because the PFM - 
Finish Period by Month validation requires a field with token KNTA_PLAN_START_DATE for the SQL 
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to be executed, while for most of non-PFM-Proposal request types, there is no such field. 
(QCCR1L43340)

Workaround: Do not use PFM - Finish Period by Month validation for non-PFM-Proposal request 
types.

Limitation: When using a jump/receive workflow, you add a new package line to a package after you 
have submitted all the package lines and started the package workflow for any one of them. As a result, 
the package and the request are not insynchronization. (QCCR1L45417)

Workaround: Add all package lines before you start the package workflow for any one of them.

Problem: (Sun Solaris only) You submit a request using the workflow whose initial step is an 
execution workflow step. The workflow cannot proceed to the next step and you see an error message 
similar to the follows on the Request Execution Log page:

The attachment file could not be downloaded. The file: REQ_

XXXX/REQ_XXXX_BID_XXXXX.html no longer exists on the server…

This is due to a system limitation with Sun Solaris that one directory can only contain 32k 32768 sub-
directories (maybe 64k 65536 in some versions). When PPM workflow in a request execute a 
command, it creates a folder for each request to log the execution information, so it may exceed the 
limitation if there are many requests that will execute a command in workflows. (QCCR1L47984)

Workaround: A task is added to the Directory Cleanup Service to delete the request log files 
periodically. The default value of the WEB_FILE_CACHE_LIFETIME_IN_DAYS server configuration 
parameter is 7. Therefore, request log files created 7 days ago are deleted. You can increase or 
decrease the server configuration parameter value as needed.

Problem: When a request is created in a non-English-speaking region with a regional language other 
than English, users cannot receive email approval notifications. (QCCR1L48350)

Workaround: Install Multilingual User Interface (MLU) in PPM Center.

Problem: There is only one request on the last page of the Request List portlet on the Dashboard page. 
You open the request and cancel it. When you go back to the Dashboard page, you see no results from 
the Request List portlet. The portlet works again if you reopen the Dashboard page. (QCCR1L48445)

Workaround: None.

HP Deployment Management

Problem: Transfer of bundle to Destination environment fails as the ksc_copy command is not 
working for the Request Type Migrator. (QCCR1L40858)

Workaround: Set variable DISABLE_SCP_FILENAME_QUOTE in the Environment User Data.
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Problem: File transfer from source environment to destination environment using Reflection for Secure 
IT for Unix (version 7.1) server fails when the environments were configured in a workflow execution 
step. (QCCR1L24976)

Workaround: To use Reflection for Secure IT for Unix server to transfer files successfully,

 1. Create a new Environment User Data using the following values:

 n Field Prompt: DISABLE_SCP_FILENAME_QUOTE

 n Token: DISABLE_SCP_FILENAME_QUOTE

 n Enabled: Yes

 n Validation: Yes No Radio Buttons

 n User Data Column: Select a value from the drop down list.

 n Display: Yes

 n Display Only: Never

 n Required: Never

Then, in the Environment you want to use, enable the newly created user data.

For more information about creating and enabling user data, see the HP Deployment Management 
Configuration Guide.

 2. Note down the Server environment and Client environment values you used in step 

 3. Configure the workflow execution step and use the Server environment and Client environment 
values you noted down earlier for Source Environment and Dest Environment fields.

Problem: If you used environment tokens in Object Type with special command ksc_copy_server_
server and set the Source and Destination environments as its arameters, file transfer from source 
environment to destination environment with Reflection for Secure IT for Unix (version 7.1) server fails. 
(QCCR1L27758)

Workaround: Modify the environment settings by following the instructions described in the 
WORKAROUND for QCCR1L24976.

HP Portfolio Management

Limitation: The COST_CAPITALIZATION_ENABLED server.conf parameter cannot be changed 
using the Administration Console. (QCCR1L41323)
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Workaround: The flag can be changed directly in the server.conf parameters as needed. However, HP 
strongly recommends not disabling cost capitalization if it has been enabled.

Problem: Transaction History and Notes History cannot be enabled in the Associated Programs field 
of a PFM - Asset, PFM - Project, or PFM - Proposal request header type or a copy of one of these 
request header types. Selecting Yes or No does not enable these auditing features. (QCCR1L26865)

Workaround: None.

HP Program Management

Problem: Program risk request types are not available.

Workaround: Program risk request types are part of the Best Practices content. Best Practices must 
be installed/re-installed in order to use this content.

HP Project Management

Limitation: If you use Firefox browser and click Modify Search on the Add 
Projects/Tasks/Requests/Packages to Time Sheet window, the previously provided search criteria are 
wiped out. (QCCR1L53555, QCCR1L53570)

Workaround: Use Internet Explorer browser instead, or complete the filter fields again in Firefox 
browser.

Problem: When exporting a financial summary to an Excel file, the data format in Excel differs from 
that in PPM Center. (QCCR1L44632)

Workaround: Change the regional settings of your operating system from the Control Panel, so that 
they are the same as your current regional settings set on the Regional Settings tab of the Edit My 
Profile page (Open > Administration > Edit My Profile > Regional Settings).

Problem: When exporting a work plan to both PDF and Excel, if the work plan has a task with a name 
that contains double-byte numbers, the exported PDF differs from the exported Excel. In the exported 
PDF, the task name does not contain the double-byte numbers. (QCCR1L14109)

Workaround: None.

Problem: If a user edits a task’s external predecessor from the work plan page, when the task is 
saved, the external predecessor is deleted. (QCCR1L27616)

Workaround: Use the Task Details page to edit a task’s external predecessors. Do not edit external 
predecessors from the work plan page.
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Problem:When installing the Plug-in for PPM for all users, the installation finishes but the HP PPM 
Center menu is not visible in Microsoft Project. This is because Microsoft Office 2007 Hotfix 976811 
only supports operating systems Windows Vista and Windows XP. (QCCR1L39188)

Workaround: Install the Plug-in for PPM for current user only.

Problem: When exporting a financial summary to an Excel file, the data format in Excel differs from 
that in PPM Center. (QCCR1L44632)

Workaround: Change the regional settings of your operating system from the Control Panel, so that 
they are the same as your current regional settings set on the Regional Settings tab of the Edit My 
Profile page (Open > Administration > Edit My Profile > Regional Settings).

Problem:  When the structure of a work plan has been changed, the values for Planned Value, Earned 
Value, CPI, and SPI become 0 after the Cost Rollup Service runs. (QCCR1L56155, QCCR1L55737)

Workaround: To obtain values for Planned Value, Earned Value, CPI, and SPI for earned value 
analysis purpose, after any work plan structure change, recreate a new baseline for your project.

Problem: On the Cost tab of the Project Overview page, when you adjust the scope in the Earned 
Value Analysis view to model impact to the project, the diagram in the Earned Value Analysis chart 
may display out of the frame if the EACT value covers months earlier than the starting month on X-axis. 
(QCCR1L55862)

Workaround: None.

Integrations

Integrations - Quality Center (ALM)

Limitation: Integration fails when QC/ALM project names contain non-Latin characters (for example, 
Russian). (QCCR1L47799)

Workaround: Use latin characters only for QC/ALM project names. The QC/ALM RESTful API does 
not support non-latin characters.

Problem: (Integration with Quality Center version 10.00 only) After upgrading PPM Center, if you 
reload the “QC/ALM Defect Information” field group (it is Quality Center Defect Information in PPM 
Center version 9.14 or earlier) in a Request Header Type of a request type (by unchecking the field 
group first and then checking it again), and create a defect in Quality Center to create a new request in 
PPM Center, errors may occur. (QCCR1L46633)

Workaround: Modify the Request Header Type by restoring the layout of the field group fields on the 
Layout tab to the default. For example, make sure that QC/ALM Instance the first field, QC/ALM 
Domain the second, QC/ALM Project the third, and so on.

Release Notes
Overview of Version 9.30

HP Project and Portfolio Management Center (9.30) Page 19 of 34



Limitation: Cannot synchronize status of defects or requirements from Quality Center 10.00 or HP 
ALM 11.x when the value of the status in QC or HP ALM is in a non-English language, for example, 
Chinese. (QCCR1L47995)

Workaround: None.

Integrations - View Project Quality

Problem: (IE only) When adding an integration configuration on the View Project Quality integration 
landing page, entering a long name in the QC/ALM Server Name field may cause display alignment 
issue with the list of View Project Quality integration configurations.

Workaround: Enter a shorter name instead.

Limitation: When mapping a PPM task to an HP ALM release, if the values in the target HP ALM 
server are in German or Korean, after you added a filter and specified an ALM Criteria, and then 
clicked the selector icon for Criteria Value, the available values retrieved by HP ALM REST API from 
HP ALM may display as garbled characters in the popup window, for example, "???".

Workaround: None.

Limitation: When mapping a PPM task to an HP ALM release and adding filters, some invisible fields 
in HP ALM are also retrieved by the HP ALM REST API and are displayed in the ALM Criteria column 
on the Quality tab of the Task Details page. Such invisible fields include: 

 l For Defect: To Mail

 l For Requirement: Some fields that start with RBQM.

Workaround: None.

Problem: When mapping a PPM task to an HP ALM release and adding filters, though the Subject 
field value is empty in the Criteria Value column on  the Quality tab of the Task Details page, the HP 
ALM REST APIs get test plan folder name as available values for this field from HP ALM.

Workaround: None.

Integrations - Universal CMDB

Problem: (PPM Center version 9.20 and later) When you integrate PPM Center with Universal CMDB 
for impact analysis, the ";" character is not supported. If a UCMDB CI name contains a ";" character, it 
would be treated as a separator and two entries would show up in the Impacted Configuration Items 
section of the PPM Center request after you loaded selected CIs into the request. (QCCR1L52964)

Workaround: None.
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Integrations - HP Agile Manager

Limitation: After the mapping relationship between a PPM Center task and HP Agile Manager is 
established, the Agile release related charts in the Hybrid Project tab on the Task Details page of the 
mapped task are not displayed if you use customized proxy or global proxy for PPM Server to access 
HP Agile Manager. (QCCR1L56200)

Workaround: None.

Limitation: Starting from version 9.30, the integration with HP Agile Manager is realized by the 
solution Agile Open SDK. Using the integration solution enabled by the Agile Open SDK, you cannot 
integrate PPM Center time sheets with HP Agile Manager. (QCCR1L55822)

Workaround: If you still want to use the integration between PPM Center time sheets and HP Agile 
Manager, you can choose to stay on version 9.22, or to wait for the next available patch release on top 
of version 9.30 when this integration is available.

Limitation: If you indent or outdent unmapped tasks to make them become the leaf tasks of the tasks 
mapped with waterfall projects or agile projects, the unmapped tasks may be deleted after 
synchronization. (QCCR1L55750)

Workaround: HP Recommend that you do not indent or outdent unmapped tasks to make them 
become the leaf tasks of the tasks mapped with waterfall projects or agile projects.

Installation

Limitation: (AIX system only) When you perform upgrade on AIX system, if you choose a double-type 
language (for example, Simplified Chinese, Korean, or Japanese), and you use MobaXterm as client 
side tool to connect to AIX, you may experience the issue that some labels names are not shown as 
well as an upgrade error.(QCCR1L49613)

Workaround: To resolve the issue, clear data from the KINS_ACTIONS table, and retry the step 
where you got an upgrade error earlier.

iPad Certification

Problem: In the My Tasks portlet on the PPM Dashboard page, after you click Edit Effort 
Breakdown, input fields in the pop-up window are too narrow to display the inputted data.

Workaround: None.
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Problem: You cannot click the column headings to change the sort order of the table on the following 
pages:

 l The Subportfolios, Programs, and Proposal/Project/Asset tabs of the View Portfolio page

 l The Scenario Content section of the Scenario Comparison page.

Workaround: None.

Limitation: After you add a reference in the References section of the Program Overview page or on 
the References tab of the Task Details page, the newly added reference is not displayed in the 
References to be added on Save field. (QCCR1L49441)

Workaround: None.

Problem: The View Work Plan page and the Project Settings page may not work properly. For 
example, when you click the Name or the Predecessors column on the View Work Plan page, the 
work plan gets truncated.

Workaround: HP recommends that you perform such actions on your computer.

Problem: You cannot perform any action on the Administration Console page.

Workaround: None.

Problem: You cannot use features related to right-clicking on PPM Center pages. This is because 
iPad does not support right-clicking.

Workaround: None.

Problem: You may encounter style problems when using PPM Center. For example, table on the 
Manage Resource Pool page exceeds the right boarder of the page.

Workaround: None.

Problem: You cannot export PPM Center pages to PDF/EXCEL files.

Workaround: None.

Limitation: You cannot see tooltips on PPM Center pages. This is because Apple Safari in mobile 
devices does not support Alt/Title attribute.

Workaround: None.

Limitation: (Apple IOS 5.0 only) You cannot upload files on PPM Center pages, this is because Apple 
IOS 5.0 does not support uploading files.

Workaround: None.
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Limitation: Due to iPad limitations, you cannot use features utilizing Microsoft Silverlight, or 
download/upload EXCEL files in Application Portfolio Management.

Workaround: None.

Multilingual User Interface (MLU)

Limitation: The Arabic language is not available in the PPM Center upgrade wizard. (QCCR1L55950)

Workaround: None.

Limitation: You can not save scenarios with special characters, such as Chinese characters.  
(QCCR1L55863)

Workaround: None.

Problem: When deploying language packs, the logs will show the following error for all languages, 
except for the system language:

[java] java.sql.SQLIntegrityConstraintViolationException:
 ORA-02291: Integrity-Constraint (GEEK_01.KNTA_NOTIFICATIONS_ LOC_FK) violated 

This error has no functional impact. (QCCR1L27539).

Workaround: None.

Problem: When installing PPM Center on a localized (for example, Swedish) Windows platform, at the 
MLU step of the installer wizard, English and the language of the system (in this case, Swedish) are 
selected by default. When you launch PPM Center after the installation, only English language is 
available in the Language drop-down list on the PPM Center logon page. The default selected language 
of the system was not installed. 

If, at the MLU step of the installer wizard, you select a third language (say, Korean) in addition to 
English and the language of the system (in this case, Swedish) which are selected by default. When 
you launch PPM Center after the installation, only English and the third language (in this case, Korean) 
you selected during the installation are available in the Language drop-down list on the PPM Center 
logon page. The default selected language of the system was not installed.

(QCCR1L55604)

Workaround: After the installation of PPM Center instance, run the kDeploy script as follows to 
redeploy the desired language pack: 

sh ./kDeploy.sh -lang <locale>

In this case, run the following to deploy the Swedish language pack: 
sh ./kDeploy.sh -lang sv

Problem: Some language names still display in English instead of in Arabic at the MLU step of the 
Install Wizard during PPM server installation for Arabic.  (QCCR1L55838)
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Workaround: None.

Limitation: PPM Center can not display Arabic strings properly in the following situations:

 l After applying the Arabic language pack, on some pages (for example, the Request Search Result 
page and the Project Overview page), PPM Center could not display Arabic strings properly if the 
strings (say, project names) contain any of the following combinations: 

 n Number + Arabic + non-Arabic language (with or without space)

 n Number + Arabic + Number (with or without space)

 n Non-Arabic language + Arabic + Number (with or without space)

 n Arabic + non-Arabic language +Number (with or without space)

 n Arabic + Number + non-Arabic language (with or without space)

The Arabic word is always moved to the right side in the output display. (QCCR1L54179, 
QCCR1L54453, QCCR1L54300, QCCR1L54292, QCCR1L54519, QCCR1L54258)

 l Left alignment issue of UI elements. PPM Center UI elements are still left-aligned after applying the 
Arabic language pack.

 l Hard-coded UI elements display issue. If a PPM Center page contains hard-coded UI elements (for 
example, punctuation symbols like full stop and comma, and Yes/No radio buttons), there are 
display issues when the page is accessed in Arabic language:

 n Full stop and comma display issue. The locations for full stop and comma are hard-coded, 
therefore you see them stay where they are even after applying the Arabic language pack. For 
example, the full stop stays at the beginning  of an Arabic sentence, instead of moving to the left 
end, which is the correct location for the full stop.

 n Radio buttons display issue. The layout of the radio buttons with Arabic translations on the page 
look confusing. (QCCR1L54181, QCCR1L54319)

 l Parentheses display issue. When an Arabic string contains parentheses, that is, "(" and ")", PPM 
Center can not display the string properly. (QCCR1L54259, QCCR1L54518)

Workaround: None.

Problem: A Java script error message (Errors on this webpage might cause it to work 
incorrectly) pops up in the following scenarios: 

 l Loging in to PPM

 l Loading PPM Dashboard

 l Opening the Project Overview page
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 l Deleting a request

 l Opening or customizing a portlet

Workaround: You can click Close in the message window to safely ignore the Java script error. No 
functional impact found so far.

Limitation: PPM Center does not support lunar calendars, therefore you cannot find Islamic (or Hijri) 
calendar for Arabic countries. (QCCR1L54422)

Workaround: None.

Problem:  The Done icon is truncated on Arabic PPM Center pages. (QCCR1L54321, 
QCCR1L54271)

Workaround: None.

Problem:  When creating an entity (say, a request) without filling all required fields, links to required 
fields are missing from the warning message that displays when you save the entity. 

Workaround: None.

Problem:  After exporting a page or a portlet to PDF in Arabic session, the exported PDF file is almost 
empty, it cannot display Arabic strings.

Workaround: None.

Platform

Problem: In previous versions, if no port number is specified for LDAP server URL, the default port 
number 389 is used. In version 9.30, an error occurs if no port number is specified for LDAP server 
URL, even when you use SSL-enabled LDAP server. (QCCR1L56232).

Workaround: Add the port number 389 in the LDAP URL if you use the default port number, no matter 
whether or not you use SSL-enabled LDAP server.

Limitation: For the drop-down list validations that are used in workflow steps, PPM Center does not 
deal with tokens with the prefix REQ, REQD, or WF. (QCCR1L53969).

Workaround: None.

Limitation:When there is no shared folder in a cluster for the server.conf file, changes made to the 
server configuration parameters through Admin Console when logged into a specific node in the cluster 
are not propagated to the server.conf file in other nodes. (QCCR1L45580)

Workaround: There are two workarounds:
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 l Make sure you make changes to server configuration parameters for each node in the cluster 
manually. Or,

 l Create a shared folder for the server.conf file to give all nodes in the cluster access to the same 
server.conf file.

Limitation: You may encounter an error when opening a subworkflow in Graphical View: 
java.io.IOException: too many colors for a GIF (QCCR1L48353)

Workaround: Do the following:

 1. Set the com.kintana.core.server.LOW_COLOR_WF_IMAGE parameter to true in 
server.conf.

 2. Go to the <PPM_Home>/bin directory and run the following command: 

sh ./kUpdateHtml.sh

 3. Restart PPM server.

Problem: (Non-Windows platforms) When a non-root user starts PPM Server on a non-Windows 
platform, some warning messages may pop up. (QCCR1L55730)

Workaround: Simply ignore these warning messages as they have no impact to the system.

Platform - UI

Limitation: (Google Chrome only) Single ACL displays as a multiple ACL in Chrome browser. 
(QCCR1L55548)

Workaround: None.

Problem: (Internet Explorer 9 only) When accessing PPM Center using Quirks mode of IE 9, the 
following issues may occur:

 l The autocomplete icon in the table component disappears if any table field contains long text.

 l Performance issue when rendering request pages if there are large amounts of fields in the request 
type. 

(QCCR1L55027)

Workaround: None.

Limitation: (Google Chrome only) When you access PPM Center using Google Chrome, the PPM 
Center pages layout may not display properly, especially buttons at the bottom of a page may be 
truncated.
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Workaround: To display PPM Center pages properly, 

 1. In Google Chrome, click the Chrome menu  on the browser toolbar.

 2. Select Settings, and then click Show advanced settings.

 3. Go to the Web content section, for the Font size field, click the Customize fonts button.

 4. Change Minimum font size to Tiny.

 5. Click OK.

Workbench

Problem: You may experience problem when trying to export large workflow diagram from PPM 
Workbench.

Workaround: If you open PPM Workbench by clicking Open > Administration > Open Workbench, 
you may need to increase your heap size from Java Plug-in in order to export large workflow diagram 
from PPM Workbench.

To do so,

 1. On Windows platform, click Start > Control Panel > Java Plug-in.

 2. In the Java Control Panel dialog, select the Java tab, and click View under Java Applet Runtime 
Settings.

 3. Find the most recent Version Java runtime line, double click in the Java Runtime Parameters field 
and add -Xmx<heap_size>m. <heap_size> shall be a number appropriate to your system. For 
example, -Xmx300m, that is, setting Java maximum heap size to 300 MB.

 4. Click OK.

Note: Make sure you exit all web browser windows.

Limitation: When users open PPM Workbench in 64-bit Internet Explorer by clicking Open > 
Administration > Open Workbench, they are prompted to install Java plug-in 1.7.0. After installing 
the Java Plug-in by following the screen instructions, they still receive prompt asking them to install 
Java plug-in 1.7.0.

Workaround: Oracle provides automatic installation kit for 32-bit Java Plug-in 1.7.0 only. To install the 
64-bit Java plug-in 1.7.0, go to Oracle website, manually download and install the 64-bit Java plug-in 
1.7.0.
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HP Resource Management

Problem: Data display format inconsistency between the staffing profile page and the Analyze 
Assignment Load portlet: the staffing profile page displays data by hours in the format of one decimal 
place, while the Analyze Assignment Load portlet displays data in the format of two decimal places.

Workaround: None.

HP Time Management

Problem: (Internet Explorer 9 only) Blocking message pops up when exporting time sheets to Excel 
via HTTPS after upgrading PPM Center to version 9.14.0002. (QCCR1L50117)

Workarounds: There are two workarounds available. 

Note: Try Workaround 2 only when Workaround 1 is not allowed by your organization's IT policies.

Workaround 1: Uncheck the Do not save encrypted pages to disk option in your advanced Internet 
Explorer settings. 

To do so, on the Tools menu in Internet Explorer 9, click Internet Options, click the Advanced tab, 
click to clear the check mark from the Do not save encrypted pages to disk check box in the 
Security area, and then click OK. (This is the default Internet Explorer setting.)

Workaround 2: Edit registry key. To do so,
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 1. Start Registry Editor.

 2. Locate the desired registry key.

 n For a per-user setting, locate the following registry key:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Internet Settings

 n For a per-computer setting, locate the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Internet 
Settings

 3. On the Edit menu bar, click New > DWORD (32-bit) Value, and then add the following value 
name: BypassSSLNoCacheCheck.

 4. Right click on BypassSSLNoCacheCheck and click Modify. 

 5. In the Value data field, enter 00000001 and click OK.

 6. Exit Registry Editor.

Problem: You may get the following session error while trying to open a time sheet using the hyperlink 
on the spreadsheet created from the Approve Time Sheet portlet.

Your session has timed out due to inactivity. Any unsaved changes have been lost. 
Please reload the Time Sheet to continue with your changes.

(QCCR1L45610)

Workaround: To fix the issue, use the workaround provided by Microsoft: 
http://support.microsoft.com/kb/218153
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PPM Workbench

Problem: PPM Workbench cannot open after installing JRE7u25. This is caused by change in Java 
applet made by Oracle with the latest Java plug-in. For more details, see 
http://www.oracle.com/technetwork/java/javase/7u25-relnotes-1955741.html. (QCCR1L52313) 

Workaround 1: Uninstall JRE7u25, then reinstall and use JRE7u11.

The latest Java plug-in causes the issue with the PPM Workbench, therefore it is recommended to use 
JRE7u11.

Workaround 2: Clear Java cache settings and disable certificate revocation checking. To do so,

 1. Go to Start > Control Panel > Java. 

The Java Control Panel window opens.

 2. Clear Java cache settings. 

 a. On  the General tab, click Settings in the Temporary Internet Files section. The Temporary 
Files Settings dialog opens.

 b. Click Delete Files.The Delete Files and Applications dialog opens.

 c. Select Cached Applications and Applets and click OK.

 3. Disable certificate revocation checking. 

 a. Go to the Advanced tab of the Java Control Panel window. 

 b. Expand Security > General, uncheck the Check certificates for revocation using 
Certificate Revocation Lists (CRLs) option, and click OK.

 4. Open the PPM Workbench again.

Caution: Disabling on line revocation checking should only be considered in managed 
environments as it decreases security protections.

Upgrade

Limitation: After upgrading PPM Center to version 9.30, as a result of introducing two additional 
columns to the TM_USERS_BILLING_APPROVERS table and TM_USERS_TIME_APPROVERS 
table, the database space used by both tables as well as their indexes may be doubled. This means 
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that the tablespace may not be enough if your organization have a huge amount of time sheet approvers 
or billing approvers. (QCCR1L55661)

Workaround: Check tablespace before upgrade, and expand data tablespace and index tablespace if 
necessary.

Documentation Errata
The following documentation items are incorrect.

Installation and Administration Guide

Incorrect description for the kBudgetBenefitImport.sh script

Location: Installation and Administration Guide, version 9.20, 3rd edition, page 500

Error: Incorrect description was provided for the kBudgetBenefitImport.sh script. 

Correction:  The correct description shall be as follows:

The kBudgetBenefitImport.sh script is used to export/import orphaned budgets/benefits to/from csv 
files.

Run the script as follows:

kBudgetBenefitImport.sh

    [-h | -help | -?]

    [-export <csv_filename>.csv <log_filename>.log]

    [-import <csv_filename>.csv <log_filename>.log]

    [commit]

where,

<csv_filename>.csv represents the csv file to store orphaned budgets/benefits.

<log_filename>.log represents the log file.

commit is to commit changes to the database. If not specified, only .log file is created.

Note: This script is obsolete and removed in 9.30.

HP Project Management User’s Guide
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Insufficient information about the rule event "apply on page load"

Location: HP Project Management User’s Guide, version 9.20, page 194

Error: The information about the rule event "apply on page load" is insufficient.

Correction: Add a note as follows in the descriptions of the rule event "apply on page load":

Note: Rules defined for this event are not triggered on the look-ahead page.

Security Model Guide and Reference

Insufficient information about copying and disabling users in the guide

Location: HP Security Model Guide and Reference, version 9.20

Error: The guide does not include descriptions about copying and disabling users.

Correction: Add two sections "Copying Users" and "Disabling Users" in the guide.

For detailed information, see Security Model Guide and Reference for version 9.30.

Inconsistent behaviors between two ways to disable users are not 
documented

Location: HP Security Model Guide and Reference, version 9.20

Error: The guide does not describe the inconsistent behaviors between disabling a user by using the 
Disable button and doing that by using the End Date field.

Correction: Add the following note in the guide:

Note: If the value of the End date field is earlier than or equal to the current date, you disable the user 
when it is created. 

If you disable a user in this way, the user would not be listed in the search result after you search for it 
by  the  criteria "Product" (System Level Licenses and System Level Licenses), because when 
calculating licenses, PPM Center ignores users whose end dates are in the past. However, if you 
disable a user by using the Disable button, the user is listed in the result regardless of how you set the 
search criteria "Product". 

Release Notes

Insufficient information about  skipping the Request Creation Confirmed page

Location: Release Notes, version 9.22
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Error: Insufficient information about the Request Details page displays incorrect request status after 
skipping the Request Creation Confirmed page

Correction: Add a note as follows:

Note: If an execution workflow step is set as the first step, the step may not finish executing when you 
are directed to the Request Details page, even when you select the option Finish Execution before 
displaying the request page to the user in the Execution window of PPM Workbench. In this case, you 
should refresh the Request Details page after the step completes the execution so that PPM Center 
can display correct request status and you can make further changes to the request.

HP Demand Management Configuration Guide 

Insufficient information about the configuration of the  Multi-Select Enabled 
option

Location: HP Demand Management Configuration Guide, version 9.20

Error:The descriptions about the configuration of the Multi-Select Enabled option when creating a 
request type field.

Correction: Add the content as follows into the description of the Multi-Select Enabled option:

If you selected a non-ACL component for the validation, users cannot select more than one value, 
regardless of whether or not the Multi- Select Enabled option is enabled and whether or not its value is 
Yes. This also applies to Web services.

Operational Reporting Administrator’s Guide

Incorrect instruction about preparing to upgrade to Operational Reporting 
Content Pack 2.0

Location: Operational Reporting Administrator’s Guide for Content Pack 2.0, page 39

Error: Step 3 of the instruction for preparing to upgrade to Content Pack 2.0 is incorrect.

Correction: Replace step 3 with the following:

Extract the contents of the Operational Reporting for PPM Center Content Pack 2.0 upgrade bundle to 
its own directory (hereinafter referred to as the <Op_Reports_Home> directory).  
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an 
email client is configured on this system, click the link above and an email window opens with the 
following information in the subject line:

Feedback on Release Notes (Project and Portfolio Management Center 9.30)

Just add your feedback to the email and click send. 

If no email client is available, copy the information above to a new message in a web mail client, and 
send your feedback to HPSW-BTO-PPM-SHIE@hp.com.

We appreciate your feedback!
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